Contents

Legal Notices..................................................................................................................................................3
Introduction....................................................................................................................................................6

1 SOLIDWORKS PDM......................................................................................................................7
  Installation Changes for SOLIDWORKS PDM.........................................................................................7
    Installing Using the SOLIDWORKS Installation Manager.................................................................8
    Installing Using the SOLIDWORKS PDM InstallShield Wizard......................................................9
  Modifying Custom Properties of PDFs Using PDF Plug-in (For SOLIDWORKS PDM Professional only).................................................................................................................................9
    Mapping Custom Properties to PDF Cards..............................................................................................10
  Reference Handling for Moved or Renamed Files......................................................................................10
  Rename a File in SOLIDWORKS FeatureManager Design Tree.........................................................11
  Resize Thumbnail Previews of SOLIDWORKS Files in Tables.............................................................11
    Warning Icons and Background Colors in the SOLIDWORKS PDM Task Pane..............................12
  SOLIDWORKS PDM Standard...............................................................................................................12
    Sorting Columns in Tables.....................................................................................................................16
      Sorting Order in Columns.....................................................................................................................16
      Table Control Settings and Sorting Behavior....................................................................................17
  Synchronizing a Revision Variable to a Revision Number .................................................................17
    Set Revision Enhancements..................................................................................................................18
  Using Windows Search for Content Search............................................................................................19
    Setting Up Windows Search................................................................................................................19
Legal Notices

© 1995-2016, Dassault Systemes SolidWorks Corporation, a Dassault Systèmes SE company, 175 Wyman Street, Waltham, Mass. 02451 USA. All Rights Reserved.

The information and the software discussed in this document are subject to change without notice and are not commitments by Dassault Systemes SolidWorks Corporation (DS SolidWorks).

No material may be reproduced or transmitted in any form or by any means, electronically or manually, for any purpose without the express written permission of DS SolidWorks.

The software discussed in this document is furnished under a license and may be used or copied only in accordance with the terms of the license. All warranties given by DS SolidWorks as to the software and documentation are set forth in the license agreement, and nothing stated in, or implied by, this document or its contents shall be considered or deemed a modification or amendment of any terms, including warranties, in the license agreement.

Patent Notices

SOLIDWORKS® 3D mechanical CAD and/or Simulation software is protected by U.S. Patents 6,219,049; 6,219,055; 6,611,725; 6,844,877; 6,898,560; 6,906,712; 7,079,990; 7,477,262; 7,558,705; 7,571,079; 7,590,497; 7,643,027; 7,672,822; 7,688,318; 7,694,238; 7,853,940; 8,305,376; 8,581,902; 8,817,028, 8,910,078; 9,129,083; 9,153,072 and foreign patents, (e.g., EP 1,116,190 B1 and JP 3,517,643).

eDrawings® software is protected by U.S. Patent 7,184,044; U.S. Patent 7,502,027; and Canadian Patent 2,318,706.

U.S. and foreign patents pending.

Trademarks and Product Names for SOLIDWORKS Products and Services

SOLIDWORKS, 3D ContentCentral, 3D PartStream.NET, eDrawings, and the eDrawings logo are registered trademarks and FeatureManager is a jointly owned registered trademark of DS SolidWorks.

CircuitWorks, FloXpress, PhotoView 360, and TolAnalyst are trademarks of DS SolidWorks.

FeatureWorks is a registered trademark of Geometric Ltd.


Other brand or product names are trademarks or registered trademarks of their respective holders.

COMMERCIAL COMPUTER SOFTWARE - PROPRIETARY

The Software is a “commercial item” as that term is defined at 48 C.F.R. 2.101 (OCT 1995), consisting of “commercial computer software” and “commercial software documentation” as such terms are used in 48 C.F.R. 12.212 (SEPT 1995) and is provided to the U.S. Government (a) for acquisition by or on behalf of civilian agencies, consistent with the policy set forth in
48 C.F.R. 12.212; or (b) for acquisition by or on behalf of units of the Department of Defense, consistent with the policies set forth in 48 C.F.R. 227.7202-1 (JUN 1995) and 227.7202-4 (JUN 1995)

In the event that you receive a request from any agency of the U.S. Government to provide Software with rights beyond those set forth above, you will notify DS SolidWorks of the scope of the request and DS SolidWorks will have five (5) business days to, in its sole discretion, accept or reject such request. Contractor/Manufacturer: Dassault Systemes SolidWorks Corporation, 175 Wyman Street, Waltham, Massachusetts 02451 USA.

Copyright Notices for SOLIDWORKS Standard, Premium, Professional, and Education Products

Portions of this software © 1986-2015 Siemens Product Lifecycle Management Software Inc. All rights reserved.

This work contains the following software owned by Siemens Industry Software Limited:


Portions of this software © 1998-2015 Geometric Ltd.

Portions of this software incorporate PhysX™ by NVIDIA 2006-2010.

Portions of this software © 2001-2015 Luxology, LLC. All rights reserved, patents pending.

Portions of this software © 2007-2015 DriveWorks Ltd.

Copyright 1984-2010 Adobe Systems Inc. and its licensors. All rights reserved. Protected by U.S. Patents 5,929,866; 5,943,063; 6,289,364; 6,563,502; 6,639,593; 6,754,382; Patents Pending.

Adobe, the Adobe logo, Acrobat, the Adobe PDF logo, Distiller and Reader are registered trademarks or trademarks of Adobe Systems Inc. in the U.S. and other countries.

For more DS SolidWorks copyright information, see Help > About SOLIDWORKS.

Copyright Notices for SOLIDWORKS Simulation Products

Portions of this software © 2008 Solversoft Corporation.

PCGLSS © 1992-2014 Computational Applications and System Integration, Inc. All rights reserved.

Copyright Notices for SOLIDWORKS Standard Product

© 2011, Microsoft Corporation. All rights reserved.

Copyright Notices for SOLIDWORKS PDM Professional Product

Outside In® Viewer Technology, © 1992-2012 Oracle
© 2011, Microsoft Corporation. All rights reserved.
Copyright Notices for eDrawings Products

Portions of this software © 2000-2014 Tech Soft 3D.
Portions of this software © 1995-1998 Jean-Loup Gailly and Mark Adler.
Portions of this software © 1998-2001 3Dconnexion.
Portions of this software © 1998-2014 Open Design Alliance. All rights reserved.
Portions of this software © 1995-2012 Spatial Corporation.
The eDrawings® for Windows® software is based in part on the work of the Independent JPEG Group.
Introduction

This guide describes new and changed SOLIDWORKS® PDM capabilities in the 2016 release.

Intended Audience

This guide is for experienced users of the SOLIDWORKS PDM software.
SOLIDWORKS PDM Standard is a new product based on SOLIDWORKS Enterprise PDM. It is included with SOLIDWORKS Professional and SOLIDWORKS Premium.

SOLIDWORKS PDM Professional is the name of the product previously called SOLIDWORKS Enterprise PDM. It is available as a separately purchased product.

This chapter includes the following topics:

- Installation Changes for SOLIDWORKS PDM
- Modifying Custom Properties of PDFs Using PDF Plug-in (For SOLIDWORKS PDM Professional only)
- Reference Handling for Moved or Renamed Files
- Rename a File in SOLIDWORKS FeatureManager Design Tree
- Resize Thumbnail Previews of SOLIDWORKS Files in Tables
- SOLIDWORKS PDM Standard
- Sorting Columns in Tables
- Synchronizing a Revision Variable to a Revision Number
- Using Windows Search for Content Search

### Installation Changes for SOLIDWORKS PDM

You can install SOLIDWORKS PDM Standard or SOLIDWORKS PDM Professional using:

- SOLIDWORKS Installation Manager (SLDIM)
- SOLIDWORKS PDM InstallShield Wizard

Recommendation: Use SLDIM to install SOLIDWORKS PDM Standard or SOLIDWORKS PDM Professional.

You must install the SolidNetWork License Manager separately.

The installations of the SOLIDWORKS PDM clients and the SOLIDWORKS PDM servers are separate.

You can select a product type based on the license available. The following add-ins specific to the product type are available.
## Client

<table>
<thead>
<tr>
<th>Client</th>
<th>Product types and add-ins</th>
</tr>
</thead>
<tbody>
<tr>
<td>SOLIDWORKS PDM Standard</td>
<td>SOLIDWORKS PDM CAD Editor&lt;br&gt;• SOLIDWORKS&lt;br&gt;• DraftSight&lt;br&gt;SOLIDWORKS PDM Contributor&lt;br&gt;• DraftSight&lt;br&gt;SOLIDWORKS PDM Viewer: No add-in</td>
</tr>
<tr>
<td>SOLIDWORKS PDM Professional</td>
<td>SOLIDWORKS PDM CAD Editor&lt;br&gt;• Microsoft Office Integration&lt;br&gt;• SOLIDWORKS&lt;br&gt;• DraftSight&lt;br&gt;• Autodesk Inventor&lt;br&gt;• AutoCAD&lt;br&gt;SOLIDWORKS PDM Contributor&lt;br&gt;• Microsoft Office Integration&lt;br&gt;• DraftSight&lt;br&gt;SOLIDWORKS PDM Viewer&lt;br&gt;• Microsoft Office Integration</td>
</tr>
</tbody>
</table>

## Installing Using the SOLIDWORKS Installation Manager

If you install using the SOLIDWORKS Installation Manager, the following options are available:

- **Individual** install
  
  **SOLIDWORKS PDM Standard** is preselected on the Product Selection page.

  For SOLIDWORKS PDM Standard, you must install SQL Express before installing the SOLIDWORKS PDM database server. You can either install SQL Express or point to your existing SQL Express database.

  If you have a license for SOLIDWORKS PDM Professional you can install **Item Explorer**.

- **Administrative image**
  
  If your organization uses the SOLIDWORKS Administrative Image Option Editor, you can create and deploy the administrative image for SOLIDWORKS PDM simultaneously with other SOLIDWORKS products.

- **Server products**
  
  For SOLIDWORKS PDM Professional, run the installation with **Server products** selected to install the SolidNetWork License Manager, the archive server, and the database server, if these are on the same machine, or run the installation separately on two different machines to install these servers.
Installing Using the SOLIDWORKS PDM InstallShield Wizard

After you install and configure the SolidNetWork License Manager using the SOLIDWORKS Installation Manager, you can install SOLIDWORKS PDM using the SOLIDWORKS PDM InstallShield Wizard in these ways:

- SOLIDWORKS PDM Standard client or SOLIDWORKS PDM Professional client
  
  For new installations, **SOLIDWORKS PDM Standard** is preselected. You can change it to **SOLIDWORKS PDM Professional**.
  
  Based on the license available and the product type you select, different add-ins are available.
  
  If you select **SOLIDWORKS PDM Professional**, the **Customize** option appears. This option lets you install Item Explorer.

- SOLIDWORKS PDM Standard server or SOLIDWORKS PDM Professional server
  
  For SOLIDWORKS PDM Standard server, on the Server Installation page, the following options are available:
  
  - Archive Server
  - Database Server

  For new installations, these options are preselected. For upgrades, the previous selections are retained.

  For SOLIDWORKS PDM Professional server, on the Server Installation page, the following options are available:
  
  - Archive Server
  - Database Server
  - Web Server
  - Web2

  For new installations, no option is preselected. For upgrades, the previous selections are retained.

Modifying Custom Properties of PDFs Using PDF Plug-in (For SOLIDWORKS PDM Professional only)

SOLIDWORKS PDM Professional lets users read or write custom properties of PDFs using the PDF plug-in.

The PDF plug-in also maps any user-defined custom properties that are written in the Custom tab of a PDF. Previously, there was no read or write support of PDF custom properties for SOLIDWORKS PDM variables.

An administrator can map a variable to a supported Block name and Attribute name for a PDF. When a user adds a PDF to a vault and updates custom properties in the PDF, the updated custom properties appear on the PDF file data card. Similarly, when a user updates variable values on the PDF file data card, the mapped property values are updated in the PDF.
Property Mappings

<table>
<thead>
<tr>
<th>Block name</th>
<th>Attribute name</th>
</tr>
</thead>
<tbody>
<tr>
<td>CustomProperty</td>
<td>TITLE</td>
</tr>
<tr>
<td>CustomProperty</td>
<td>AUTHOR</td>
</tr>
<tr>
<td>CustomProperty</td>
<td>SUBJECT</td>
</tr>
<tr>
<td>CustomProperty</td>
<td>KEYWORDS</td>
</tr>
<tr>
<td>CustomProperty</td>
<td>PART NUMBER</td>
</tr>
<tr>
<td>CustomProperty</td>
<td>DESCRIPTION</td>
</tr>
</tbody>
</table>

The attribute, **FILE**, that represents the filename is read-only. The value is only read from the PDF.

**Mapping Custom Properties to PDF Cards**

This example describes how to map the variable Title to the custom property TITLE.

**To map custom properties to PDF cards:**

1. In the Administration tool, right-click **Variables** and click **New Variable**.
2. In the dialog box, create a variable named **Title**.
3. Click **New Attribute**.
4. Under **Selected attribute**:
   a) For **Block name**, select **CustomProperty**.
   b) For **Attribute name**, type **TITLE**.
   c) Type the file extension that contains the property.
      For example: pdf.
5. Click **OK**.
6. In the Card Editor, open the **PDF Card**.
7. Add an edit box and for **Variable name** select the new Title variable.
8. Save the card and close the Card Editor.

When a user adds a PDF to the SOLIDWORKS PDM vault, the PDF file data card shows the **Title** variable. User can read/write the custom property Title to the PDF file data card.

**Reference Handling for Moved or Renamed Files**

When you have files in the local cache that contain references, the SOLIDWORKS PDM add-in warns you if another user moves or renames the references.

Previously, if you opened a cached parent file with a referenced component that was moved or renamed by another user, the SOLIDWORKS software would open the cached file without a warning.
Now, you receive the warning:

- When you have a SOLIDWORKS file open in read-only mode and another user moves or renames references.

In the Task Pane, the SOLIDWORKS PDM add-in adds ☰ next to the names of the modified files and the add-in displays a warning message.

Do the following:

1. In the Task Pane, click the link to see details of the moved or renamed files.
2. Close and re-open the files.

The SOLIDWORKS software repoints the references to the latest file location and displays a message that files have been renamed or moved and that the references have been updated.

- When another user has moved or renamed references for a SOLIDWORKS file that is in your local cache and you open the cached parent file.

The SOLIDWORKS software automatically updates the references and displays a message that files have been renamed or moved, and that the references have been updated.

## Rename a File in SOLIDWORKS FeatureManager Design Tree

You can rename a file in the SOLIDWORKS FeatureManager design tree.

Before a user can rename a file:

- The user must load the SOLIDWORKS PDM add-in.
- The administrator must set Add or rename file permission for State Permissions and Folder Permissions.
- The user must check out the component and its referencing assembly on the same machine.

A warning message appears if any of the above conditions is not met.

In the SOLIDWORKS FeatureManager design tree, if you try to rename a component with the same name as an existing file, the duplicate filename warning appears.

This warning appears only if the administrator selects Do not allow duplicate file names in this vault in the Administration tool.

## Resize Thumbnail Previews of SOLIDWORKS Files in Tables

You can resize thumbnail previews of SOLIDWORKS files using Change Thumbnail Preview Size.

SOLIDWORKS PDM lets you select the size of thumbnail previews as Small, Medium, or Large. By default, Medium is selected. When you select the size in one table, SOLIDWORKS PDM sets the same size in applicable tables and on tabs.
To resize the thumbnail previews:

1. Right-click in the file list.
2. Click **Change Thumbnail Preview Size** and select the size to use.

The thumbnail previews for non-SOLIDWORKS files may not be clear when you select **Medium** or **Large**.

Warning Icons and Background Colors in the SOLIDWORKS PDM Task Pane

You can turn off individual warning icons and background colors that appear in the SOLIDWORKS PDM Task Pane.

**To turn off the warning icons and background colors in the SOLIDWORKS PDM Task Pane:**

1. In the SOLIDWORKS software, click **SOLIDWORKS PDM > Options > View Setting**.
2. Under **Status**, clear the check boxes for the warning icons and its background colors to suppress.

SOLIDWORKS PDM Standard

SOLIDWORKS PDM Standard is a document management product based on the same architecture as SOLIDWORKS Enterprise PDM.

You can upgrade from SOLIDWORKS PDM Standard to SOLIDWORKS PDM Professional without migrating files or data because SOLIDWORKS PDM Standard is based on the same architecture as SOLIDWORKS PDM Professional. However, you cannot downgrade a SOLIDWORKS PDM Professional vault to a SOLIDWORKS PDM Standard vault.

One license of SOLIDWORKS PDM Standard CAD Editor is included with each license of SOLIDWORKS 2016 Professional and SOLIDWORKS 2016 Premium. Licenses for non-CAD users are available as separately purchased products.

SOLIDWORKS PDM Standard uses the SolidNetwork License Manager and requires a serial number. Serial numbers for Beta testing are available to all eligible SOLIDWORKS 2016 customers. Contact your SOLIDWORKS Value Added Reseller (VAR) to obtain serial numbers.

This table shows the functionalities of each license:

<table>
<thead>
<tr>
<th>Functionality</th>
<th>SOLIDWORKS PDM Standard CAD Editor</th>
<th>SOLIDWORKS PDM Standard Contributor</th>
<th>SOLIDWORKS PDM Standard Viewer</th>
</tr>
</thead>
<tbody>
<tr>
<td>SOLIDWORKS add-in</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add and edit SOLIDWORKS files</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Integrated preview for SOLIDWORKS files</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>
This table shows differences between SOLIDWORKS PDM Standard and SOLIDWORKS PDM Professional:

<table>
<thead>
<tr>
<th>Functionality</th>
<th>SOLIDWORKS PDM Standard</th>
<th>SOLIDWORKS PDM Professional</th>
</tr>
</thead>
<tbody>
<tr>
<td>SOLIDWORKS add-in</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>eDrawings Professional</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>DraftSight add-in</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Microsoft Office add-in</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>AutoCAD add-in</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Inventor add-in</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>CAD Editor client</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Contributor client</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Functionality</td>
<td>SOLIDWORKS PDM Standard</td>
<td>SOLIDWORKS PDM Professional</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>--------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>Viewer client</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Multiple workflows</td>
<td>Limited to 1</td>
<td>❌</td>
</tr>
<tr>
<td>Workflow States</td>
<td>Limited to 10</td>
<td>✔</td>
</tr>
<tr>
<td>Parallel Approvals</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Offline mode</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Transition actions</td>
<td>✔ (Limited)</td>
<td>✔</td>
</tr>
<tr>
<td>eDrawings preview</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Multi-document preview</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>External Viewer Integration</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Templates</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Serial Numbers</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Content search (indexing)</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Integrated search tool</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Dedicated search tool</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Search favorites</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Active directory and LDAP login</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Notifications - PDM inbox (database)</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Notifications - email (SMTP)</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Functionality</td>
<td>SOLIDWORKS PDM Standard</td>
<td>SOLIDWORKS PDM Professional</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>SQL Server Express support</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>SQL Standard support</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Automated tasks</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Automated data import/export</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>API</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Custom add-in support</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Dispatch</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Item support</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Web client</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Multi-site replication</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Report generator</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Revision schemes</td>
<td>Limited to 2</td>
<td></td>
</tr>
<tr>
<td>File categories</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Version labels</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Named Bill of Materials</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Paste shared links</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Menu and toolbar customization</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Version free variables</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
### Sorting Columns in Tables

You can sort the default and custom columns in tables in ascending, descending, or default order by clicking column headers. Column sorting is useful within large datasets. Column sorting is available in all dialog boxes and on all tabs.

If you sort a column in ascending or descending order, the column is highlighted in green and an arrowhead appears.

### Sorting Order in Columns

You can sort the default and custom columns in tables in ascending, descending, or default order by clicking column headers.

Sorting sequence for ascending order:

<table>
<thead>
<tr>
<th>Column heading</th>
<th>Sorting sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>Assemblies</td>
</tr>
<tr>
<td></td>
<td>Drawings</td>
</tr>
<tr>
<td></td>
<td>Parts</td>
</tr>
<tr>
<td></td>
<td>Other (alphabetical by file type)</td>
</tr>
<tr>
<td><strong>File Name</strong></td>
<td>Alphanumeric</td>
</tr>
<tr>
<td><strong>Warnings</strong></td>
<td>Alphabetical</td>
</tr>
<tr>
<td><strong>Copy or Move</strong></td>
<td>Turned off</td>
</tr>
<tr>
<td></td>
<td>Turned on</td>
</tr>
<tr>
<td><strong>Version</strong></td>
<td>Cached value</td>
</tr>
<tr>
<td></td>
<td>If the cached values are equal, the software uses the vault values.</td>
</tr>
<tr>
<td><strong>Checked Out By</strong></td>
<td>Alphabetical</td>
</tr>
<tr>
<td><strong>Checked Out In</strong></td>
<td>Alphabetical</td>
</tr>
</tbody>
</table>
### Sorting sequence for custom columns with variable types:

<table>
<thead>
<tr>
<th>Variable type</th>
<th>Sorting sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Chronological</td>
</tr>
<tr>
<td>Decimal number</td>
<td>Numeric</td>
</tr>
<tr>
<td>Integer number</td>
<td>Numeric</td>
</tr>
<tr>
<td>Text</td>
<td>Alphabetical</td>
</tr>
<tr>
<td>Yes or No</td>
<td>Alphabetical</td>
</tr>
</tbody>
</table>

### Table Control Settings and Sorting Behavior

When you sort a column in a table, SOLIDWORKS PDM removes the file structure hierarchy. Sorting turns off **Show Tree Lines** and **Show Reference Selection Control**.

Previously, **Open File List** or **Save File List** gave results for the entire list. Now, SOLIDWORKS PDM considers filters you have applied and column sorting and lets you display all files or only the visible files.

**Open File List** includes options to open the list of files in Microsoft Excel:

- Open All
- Open Visible

Similarly, **Save File List** includes options to export the list of all files or only the visible files:

- Export All
- Export Visible

### Synchronizing a Revision Variable to a Revision Number

Administrators can map a revision variable in the workflow to synchronize it with a revision number.

Previously, to set a revision number, users had to perform an increment revision.
Now, using **Set Revision** you can synchronize a revision number to a revision value stored in a card variable, for any files including those that were previously managed outside of SOLIDWORKS PDM.

**To synchronize a revision variable to a revision number:**

1. In the Administration tool, expand **Workflows** and select a workflow.
2. Select a state.
3. On the Revision Numbers tab, set a revision number to associate with this state.
4. For **Increment by**, enter the number (typically 1) to use when the **Set Revision** command is invoked.
5. Select a revision variable in **Revision Variable**.
   - This variable must exist on the data cards of files that will have the revision synchronized.
   - The variable should be linked to the custom property holding the legacy revision value.
   - The revision number must match the revision value found in the variable for the revision to become synchronized.
6. Click **OK**.
7. Click **File > Save** to save the workflow.
   
   To verify synchronizing the revision number, manually set the revision number on a file in SOLIDWORKS PDM Explorer View. For details, see **SOLIDWORKS PDM File Explorer Help**.

**Set Revision Enhancements**

In the File Explorer, the Increment Revision dialog box has been renamed to Set Revision and redesigned to improve usability.

To display this dialog box, select a file and click **Modify > Set Revision**.

In the dialog box:

<table>
<thead>
<tr>
<th><strong>Set Revision</strong></th>
<th>Lets users select a file to set its current revision to the value that they select in the <strong>New Revision</strong> column.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Current Revision</strong></td>
<td>Displays the current revision of a file.</td>
</tr>
<tr>
<td><strong>New Revision</strong></td>
<td>By default, displays the next revision of a file. You can select a new revision for the file based on the revision scheme set on the state. When users select a revision from the list, the row is highlighted in yellow, with the modified text shown in blue and bold. The revision displayed on the <strong>Data Card Variable</strong> is flagged with <strong>On Card</strong>.</td>
</tr>
<tr>
<td><strong>Data Card Variable</strong></td>
<td>Displays the value of the revision variable that is written on the data card.</td>
</tr>
</tbody>
</table>
**Update Variable**

Lets users select a file to write the **New Revision** value to the revision variable in the workflow.

**Set All New Revision Values to Card Variable**

This right-click option copies values from the **Card Variable** column to the **New Revision** column.

### Using Windows Search for Content Search

SOLIDWORKS PDM uses the Windows Search service to perform content searches.

Previously, SOLIDWORKS PDM content search used the Microsoft Indexing Service. Because Microsoft does not support the Indexing Service for Windows 8 or Windows Server 2012 operating systems, SOLIDWORKS PDM uses the Windows Search service to support content search.

Administrators can choose an indexing method, Indexing Service, or Windows Search. Administrators of upgraded systems can still use the Indexing Service, while administrators of new systems that have not been previously indexed should use Windows Search.

**To use the Windows Search for Content Search:**

- The administrator must configure the Windows Search service and index a file vault archive folder.
- The file vault archive folder that is being indexed must be:
  - On the same machine as the configured Windows Search service.
  - Accessible to the Windows Search service to build a system index.
- If the file vault archive folder is on a different machine than an SQL server:
  - The administrator must share the file vault archive folder.
  - The logged in user running the SQL server service must have full permission to the shared folder.

When the Windows Search service builds the system index, the administrator can set up SOLIDWORKS PDM to use the system index.

### Setting Up Windows Search

Configuring the SOLIDWORKS PDM Professional Content Search to use Windows Search requires installing the Windows Search Service, adding the archive folder path to the indexing settings, and indexing the file vault archives.

**To set up Windows Search:**

1. In the Administration tool, log into the file vault to be indexed as SOLIDWORKS PDM user with **Can update index settings** permissions.
2. Right-click **Indexing** and click **Open**.
3. In the Indexing Settings dialog box, select **Index File Vault Archives**.
4. Under **Select the File Vault Indexing Method**, select **Windows Search**.
5. Under **Archive Locations**, double-click the archive path to configure index locations.
6. In the Edit File Vault Archive Folder Path dialog box, type a path to a file vault archive folder from the SQL server.

   • If the Archive server is on a different machine than the SQL server, enter a UNC path to the archive folder share.
   • The archive folders must be accessible on locally attached storage or SAN storage on the archive server machine.

7. Click **OK** twice.
   For details, see SOLIDWORKS PDM Installation Guide: Installing Windows Search Service.